1RENESAS Release Note

RZ/T2M Group
ENCOUT sample program

Summary

This document describes the RZ/T2M ENCOUT sample program package. To use this sample program,
please obtain “RZ/T2M Group Encoder I/F Configuration Library” release package (Rev.4.00 or later).

Functionality Checked Device
RSK+RZT2M Board (RTK9RZT2MOCO00000BE)
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RZ/T2M Group

ENCOUT sample program

1. Package Contents

This package contains the following contents.

1.1 Software
® Source Code

No. Name

Version number

1 RZ/T2M ENCOUT sample program

4.0

® Configuration Data

No. | Name Version number
1 RZ/T2M ENCOUT Configuration Data 1.0
2 RZ/T2M ENCOUT PINMUX Data 1.0
1.2 Document
No. | Document name Version | File name
1 RZ/T2M ENCOUT sample program 4.0 (j) r01an6416jj0400-rzt2m.pdf
Release Note (e) r01an6416ej0400-rzt2m.pdf (this document)
2 RZ/T2M Group ENCOUT sample 4.0 (j) r11an1058jj0400-rzt2m-encout.pdf
program Application Note (e) r11an1058€j0400-rzt2m-encout.pdf
3 RZ/T2M Group Encoder Divided-Output | 1.0 (j) r01an6394jj0100-rzt2m_encout.pdf
Module (ENCOUT) Application Note (e) r01an6394ej0100-rzt2m_encout.pdf
RO1AN6416EJ0400 Rev.4.00 Page 2 of 12
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2. File Structure

The file structure and contents of this package are detailed below.

Top
—r01an6416jj0400-rzt2m.pdf
—r01an6416ej0400-rzt2m.pdf
L—workspace

—Software

| |—iccarm

| | “—RZ_T2 encout.zip
| —gcc

| L—RZ_T2_encout.zip
L—Documentation

: RZ/T2M ENCOUT sample program set (IAR)

: RZ/T2M ENCOUT sample program set (e? studio)

F—r11an1058jj0400-rzt2m-encout.pdf

F—r11an1058ej0400-rzt2m-encout.pdf
F—r01an6394j0100-rzt2m_encout.pdf
L—r01an6394ej0100-rzt2m_encout.pdf

The file structure of the RZ_T2_encout.zip is shown below.

Top folder
— configuration.xml

: FSP Configuration Data

— ( Build Tool Dependent Environment File )

F— lib
| L—ecl

| — Config_Encout_v1.0_original
| L— RZT2_pinmux_v1.0.bin
L—src

— hal_entry.c

— encout_main.c

— encout_dat.asm

— siochar.c

— siorw.c

— sio_char.h

L—drv

— src

| L—r_encout_rzt2.c

L—inc
— iodefine_encout.h
—r_encout_rzt2_config.h
L—r_encout_rzt2_if.h

.dat : RZ/T2M ENCOUT Configuration Data

: RZ/T2M ENCOUT Pin Configuration Data

: ENCOUT sample program

: ENCOUT sample program

: ENCOUT Linker setup file (only e? studio)
: SCI_UART sample program

: SCI_UART sample program

: SCI_UART sample program

: ENCOUT driver file

: ENCOUT register definition file
: Configuration header file of ENCOUT driver file
: APIs of ENCOUT driver file

RO1AN6416EJ0400 Rev.4.00
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3. About ENCOUT Sample Program

This section contains information necessary to use the complete set of ENCOUT sample program.

3.1 Software Information
3.1.1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program, ENCOUT driver, and configuration data is shown in following
table. This table does not include memory size used by Encoder I/F Configuration Library, Flexible Software
Package, or C language libraries of the compiler.

Items Memory Size

EWARM e? studio

[kBytes] [kBytes]
ENCOUT driver Code 0.8 0.7
Data (with initial value) 0.0 0.0
Data (without initial value) 0.0 0.0
Constant Data 0.0 0.1
ENCOUT configuration data Constant Data 8.4 8.4
Sample program Code 1.8 2.0
Data (with initial value) 0.0 0.0
Data (without initial value) 0.0 0.0
Constant Data 0.6 0.6
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3.2 Hardware Information

3.2.1 Device
RZ/T2M

3.2.2 Target Board
(1) Board Name

RSK+RZT2M (RTK9RZT2MOCO0000BE)

(2) Setting of the Target Board

The target board configuration is as follows.
SW4-1: ON

SW4-2: OFF

SW4-3: ON

SW4-4: ON

SW4-5: OFF

SW6-1: OFF

(3) Used Pins of the Target Board
Table 3.1 shows the pins used as the phase A, B and Z output ports, and their functions.

Table 3.1 Used pins and their function

Channel Signal Name (Pin Name) | Pin Header Input/Output Description

ENCOUTO POUTAO (ENCIF2) CN1 #3 Output Phase A output pin
POUTBO (ENCIF3) CN1 #4 Output Phase B output pin
POUTZ0 (ENCIF4) CN1 #6 Output Phase Z output pin

ENCOUT1 POUTA1 (ENCIF7) CN1 #9 Output Phase A output pin
POUTB1 (ENCIF8) CN1 #11 Output Phase B output pin
POUTZ1 (ENCIF9) CN1 #12 Output Phase Z output pin
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3.3
3.3.1

Procedures on Development Environments
Preparation before Executing the Sample Program

In this sample program, communicates with the host PC. The USB connection terminal on the target board is
CN16. The terminal software of the host PC is set as shown in the following table.

Function Setting

Communication method Asynchronous serial transmit / receive
Sending / receiving order LSB first

Transfer rate 19200 bps

Character length 8 bits

Stop bit length 1 bit

Parity function None

Hardware flow control None

3.3.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for Arm (EWARM) Version 9.60.3
RENESAS FSP Smart Configurator (FSP SC) 2025-12
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs

The build procedure for the sample program is as follows.

1
2

o o b W

Note:

Copy the extracted source files to the desired location.

Copy the following files from “RZ/T2M Group Encoder I/F Configuration Library” under lib¥ecl in the
same folder as the source files. (If the “lib¥ecl” folder already exists, overwrite it.) **
lib¥ecl¥r_ecl_rzt2_iar.a

lib¥ecl¥r_ecl _rzt2_if.h

Activate EWARM.

Select [File] menu -> [Open Workspace].

Open the extracted source file RZ_T2_encout.eww.

Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *2

1. Please use Encoder I/F Configuration Library revision 4.00 or later.

2. The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of
the EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String

Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file,
rasc.exe.

If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match with your rasc.exe
installation path, please edit the buildinfo.ipcf to fit with your installation path.

RO1AN6416EJ0400 Rev.4.00 Page 6 of 12
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You can also start the FSP Smart Configurator directly from the command prompt by specifying
the folder where it is installed.

7 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rz,
rz_cfg, rz_gen, script and .setting folders will be generated.

| I8 C\1_Prog\WeriWork_C\Work EWA_960_3_fsp4.0.0\RZT2M_ENCOUT release_chk - FSP Smart Configurator - u] x

i File Window Run Help

48 [RZT2M_ENCOUT release_chk] FSP Configuration X Sl 7 FSP izati =g
Summar o 2 D ®
¥ Generate Project Content - -

Project Summary

WRENESAS

Board: RSK+RZT2M (RAM execution without flash memory)

Device: ROADTGOTSM24GEG

Core: CR52_0

FSPVersion: 4.0.0

Project Type: Flat

Location: C:/1_Prog/Work/Work_C/Work_EWA_960_3_fsp4.0.0/RZT2M_ENCOUT _release_chk <&

o

Selected software components

Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0
RSK+RZT2M Board Support Files (RAM execution without flash memory) v4.0.0
Memory Config Checking v4.0.0

)EO

| Summary | BSP | Clocks| Pins | Interrupts| Event Links| Linker Sections| Stacks| Components » SLE

[T Properties [2] Problems AE Y § = 8 & console =8

Property Value No consoles to display at this time.

8 When project generation is complete, close the Smart Configurator.
9 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2_encout.out is generated.

(4) Sample Program Execution Procedure

After executing the “build procedure”, connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].
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3.3.3 e?studio from RENESAS
(1) Build Environment

RENESAS e? studio 2025-12
Toolchain version: GNU Arm Embedded 13.3.1.arm-13-24
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.60

(3) Build Procedure for Sample Programs

1 The build procedure for the sample program is as follows.

2 Copy the following files in the "RZ/T2M Group Encoder I/F Configuration Library" to lib¥ecl in the same
folder as the source file. (If the lib¥ecl folder already exists, overwrite it.) *!
lib¥ecl¥r_ecl rzt2_gcc.a
lib¥ecl¥r_ecl rzt2_if.h

3 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing project to workspace and click [Next].

4 On the project import screen, select the folder where the sample program was expanded as the root
directory.

5 Select a project, check Copy Project to Workspace, and click [Finish].

6 Double-click the configuration.xml in the Project Explorer pane of e studio to open it.

a RZT2M_EMCOUT _release_chk - & studio — (m] X
File Edit Source Refactor MNavigate Search Project RenesasViews Run  Renesas 365 Window Help

| | ® - % viE o i Q- Q &\} Not Connected [ | g c/c+

| Project Explorer % = a = O  OQutline X =08 = |

T
= <§) 7 8 There is no active editor %)

| v == RZ_T2_encout [Debug that provides an outline,
> [l Includes

> B src

= lib
.
| = RZ_T2_encoutelijlin|

X| RZ_T2 encoutelflaunch
> () Developer Assistance

Problems Console Properties Smart Browser Smart Manual 7 8 = 8
0errors, 11 warnings, 0 others
-
Description Resource Path Location Type

» & Warnings (11 items)

54:-:3 configurationaxml - RZ_T2_encout

Note 1. Please use Encoder I/F Configuration Library revision 4.00 or later.
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7 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rz, rz_cfg, rz_gen, script and .settings folders are generated.

) RZT2M_ENCOUT release_chk - RZ_T2_encaut/canfigurationxml - & studio

u} X
[ File Edt Source Refactor Navigate Search Project RenesasViews Run Renesas365 Window Help
| ® -]~ o it Q- Q&) Mot Connected [ |
Project Explorer % = B & [RZ_T2encout] FSP Configuration X el Outline = A8 »
=K H =R )
v 5 RZ_T2_encout st Summary . ArE

Generate Project Content

There is no active editor that
> El Includes

provides an outline.
> @ src Project Summary
> B lib RENESAS
Board: RSK+RZT2M (RAM execution without flash memory)
= RZ_T2_encoutelfjlink Device: RIADTGOTEM24GEG
|¥] RZ_T2_encout.elflaunch Core: CR52_ 0
> (2) Developer Assistance Toolchain: GCC for Renesas RZ
Toolchain Version: 13.3.1.arm-13-24
FSP Version: 400
Project Type: Flat |
Location: C:/1_Prog/WorkMVork_C/Work_E2S_RZ.. M_ENCOQUT _release_chk/RZ_T2_encout ==/

Selected software components

Arm CMSIS Varsion 6 - Cors v6.104+sp4.00
RSK+RZT2M Board Support Files (RAM execulion without flash memory) v4.0.0
Memory Config Checking va00

)EO

Summary | BSP | Clocks | Pins | Interrupts | Event Links | Linker Sections | Stacks | Components
Problems X Console Properties Smart Browser Smart Manual 7 8 =
0 errors, 11 warnings, 0 others

Description Resource Path Location
> & Warnings (11 items)

Type

8 Select [Project] menu -> [Build All].
The Debug\RZ_T2_encout.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure”, connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu — [Debug As] — [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu — [Resume] to run the sample program.

RO1AN6416EJ0400 Rev.4.00
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RZ/T2M Group ENCOUT sample program

3.3.4 Execution Result
After executing the sample program, the following will be displayed on the terminal software.

ENCOUT sample program start
EC-Lib Ver.4.0.0
ENCOUT drv Ver.4.0
ENCOUTO dat Ver.1.0

ENCOUT1 dat Ver.1.0

The following signals are output to the output port described in “3.2.2(3) Used Pins of the Target Board”.

Interval=100us
w—rﬁ

—

Edge Count! 5 1 i 0 | 8 5

PhaseA_l—l_’—l_rl ﬁ |—|_|—|I

Channel 0 phaces ]| 11| |
Phase Z__ I_l Ij

Edge Ul| 5 = EEE

Phase A _l_|_,__|_|_| I_' |_|_|_|J_
Phase B | | . | | | '
Phase Z [_] l—l

Note: The channel 1 starts 50 us (carrier cycle * 1/2) earlier than the channel 0.

Channel 1

Figure 3.1 ABZ phase output signal

RO1AN6416EJ0400 Rev.4.00 Page 10 of 12
Apr 3.26 RENESAS



RZ/T2M Group ENCOUT sample program

3.3.5 Precautions for Creating Flash Boot Projects

When users want to create flash boot project (xSPI0 x1 boot mode) by using EWARM, change the alignment
specification for the beginning of USER_DATA and USER_DATA block 2 (for .rodata) to a 32-byte boundary.
The configuration data for the encoder interface is specified to be aligned to a 32-byte boundary. The change
is to prevent misalignment between the data layout transferred to RAM and the data layout recognized by the
program, even if such data is contained within .rodata.

The procedure for making changes is as follows.

Open the script/fsp_xspi0_boot.icf file and change the alignment specification at the beginning of
USER_DATA and for USER_DATA block 2 (for .rodata) to a 32-byte boundary, as indicated by the bold red
text in the figure below.

In RAM execution projects (RAM execution without flash memory), data transfer from ROM to RAM does not
occur, so this setting is unnecessary.

/* Place the variables to be used in the user program (Programs other than SSBL). */
define block USER DATA RBLOCK with fixed order, alignment = 32
{ block USER DATA RBLOCKO with aligmment = 8 { section .data init },
block USER DATA RBLOCKl with alignment = 8 { section DLIB PERTHREAD init },
block USER DATA RBLOCK2 with alignment = 32 { section .rodata init },

block USER DATA RBLOCK3 with alignment = 8 { section .version init }};

/* Allocate an address to copy the variables used in user program (Programs other than SSBL) to RAM. */
define block USER DATA WBLOCK with fixed order, alignment = 32
{ block USER DATA WBLOCKO with alignment = 8 { section .data },
block USER DATA WBLOCKl with alignment = 8 { section  DLIB PERTHREAD },
block USER DATA WBLOCK2 with alignment = 32 { section .rodata },

block USER DATA WBLOCK3 with alignment = 8 { section .version }};

RO1AN6416EJ0400 Rev.4.00 Page 11 of 12
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Revision History

Description
Rev. Date Page Summary
1.00 May.31.2022 - First Edition issued
1.10 Jun. 30.2022 3 Chapter 1.1 Modify Version number of Source code
3 Chapter 1.2 Modify File name
4 Chapter 2 Modify the file structure and contents
5 Table 3.1: Supports Flexible Software Package Version 1.0.0
7 Modify 3.3.1 Chapter name
7 Modify 3.3.2 Chapter name
8 Modify Table 3.4
- Deleted 3.7.1 Memory size
1.20 May 31.2023 2,5 Appended section 3.1.1 for memory size information.
3,4 Updated the release note version number.
- Remove unused folders of the zip sample program set.
1.30 Oct.6.2023 1,7,9 Append notes for the Encoder I/F Configuration Library revision.
1,4,6 Updated the target board name.
2,3 Updated the source code, documents revisions and the
document filenames.
Revised to control GPT, ELC from FSP API.
Updated the R_ENCOUT_GetVersion return value to “1.2”.
3 Updated file structure. (Zip file name is changed. Removed
RZ/T2M Pin Configuration data from zip file. Updated ENCOUT
configuration data filenames.)
5 Updated memory size information.
6 Updated description of the CPU board setting.
71010 Updated build environment for FSP v1.3.0. Descriptions for
development procedures.
17,18 Flowchart of the enc_main and timer interrupt function names are
revised according to the code update.
19 Description for the POSITION_MAX modification method is
updated.
2.00 Jun 28.2024 1,4,6 Updated description of the board name.
2,3 Updated the source code, documents revisions and the
document filenames.
Updated the R_ENCOUT _GetVersion return value to “2.0".
5 Updated memory size information.
71010 Updated build environment for FSP v2.0.0. Figures are replaced.
3.00 Oct 17.2025 - Separate operating environment and sample program
specifications as application note.
2,3 Update revisions of the application note and the release note.
Update sample program version to 3.0. (Support FSP v3.0.0.)
4 Update memory size information.
6to 10 Update build environment for FSP v3.0.0. Figures are replaced.
4.00 Apr 03.2026 2,3 Update revisions of the application note and the release note.
Update sample program version to 4.0. (Support FSP v4.0.0.)
4 Update memory size information.
6to 10 Update build environment for FSP v4.0.0. Figures are replaced.
11 Add section 3.3.5 Precautions for Creating Flash Boot Project.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.

+ IAR Embedded Workbench is a registered trademark of IAR Systems.

+ J-Link is a trademark of SEGGER Microcontroller GmbH.

+ Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere.
All rights reserved.

+ Additionally all product names and service names in this document are a trademark or a registered
trademark which belongs to the respective owners.




Notice

1.

10.

11.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2026 Renesas Electronics Corporation. All rights reserved.


https://www.renesas.com/
https://www.renesas.com/contact/

	1. Package Contents
	1.1 Software
	1.2 Document

	2. File Structure
	3. About ENCOUT Sample Program
	3.1 Software Information
	3.1.1 Base OS
	3.1.2 Memory Size

	3.2 Hardware Information
	3.2.1 Device
	3.2.2 Target Board

	3.3 Procedures on Development Environments
	3.3.1 Preparation before Executing the Sample Program
	3.3.2 EWARM from IAR Systems
	3.3.3 e2 studio from RENESAS
	3.3.5 Precautions for Creating Flash Boot Projects



